LENESANS Release Note

RZ/T2H Group
Encoder I/F BiSS-C sample program

Summary
This document describes the RZ/T2H Encoder I/F BiSS sample program package.

For BiSS Interface communication protocol specifications and encoder specifications, contact manufacturer
of each encoder to obtain it.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Encoder I/F BiSS-C sample program

1. Package Contents

This package contains the following contents.
The BiSS-C encoder interface of the RZ/T2H supports up to 16 axes, but the sample program uses only 1
axis of them. If you use with 2 axes or more simultaneously, modify the sample program to support required

axes.

1.1 Software
e Source code

No. Name Version
1 RZ/T2H BiSS-C sample program (CR52 ver. *) 20
2 RZ/T2H BiSS-C sample program (CA55 ver. *) 2.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Document

No. Document name Version File name
1 RZ/T2H Group Encoder I/F BiSS-C 2.01 (j) r11an0790jj0201-rzt2h.pdf
sample program Release Note (e) r11an0790ej0201-rzt2h.pdf (this document)
2 RZ/T2H Group BiSS-C sample 2.00 (j) r11an0789jj0200-rzt2h-biss.pdf
program Application Note (e) r11an0789ej0200-rzt2h-biss.pdf
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RZ/T2H Group Encoder I/F BiSS-C sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
— r11an0790jj0201-rzt2h.pdf
F— r11an0790ej0201-rzt2h.pdf
L— workspace
— Software
| F— iccarm
| | F— RZ_T2H_biss.zip : RZ/T2H BiSS sample program set
o CR52 ver. (IAR)
| | L— RZ_T2H_CA55 biss.zip
| | — RZ_T2H_CA55 0 biss : RZ/T2H BiSS sample program set
| | \ CA55 ver. (IAR)
| | L— RZ_T2H_CR52_0_primary
| | : CPU_CTRL register setting program (IAR)
| — gee
| — RZ_T2H_biss.zip : RZ/T2H BiSS sample program set
| | CR52 ver. (e2 studio)
| L— RZ_T2H_CAS55_biss.zip
| — RZ_T2H_CA55 0 _biss :RZ/T2H BiSS sample program set
| | CAS55 ver. (e? studio)
| L— RZ_T2H_CR52_0 primary
| : CPU_CTRL register setting program (e? studio)
L— Documents
— r11an0789jj0200-rzt2h-biss.pdf
L— r11an0789ej0200-rzt2h-biss.pdf

The file structure of the RZ_T2H_CR52_biss.zip and RZ_T2H_CA55 0_biss folder are shown below.
Top folder

— configuration.xml : FSP Configuration data
I ( Build Tool Dependency Environment File )
L— src
— hal_entry.c : BiSS-C sample program
— biss_main.c : BiSS-C sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— biss
— iodefine_biss.h : BiSS register definition file
F— r_biss_rzt2.c : BiSS driver file
— r_biss_rzt2_config.h : BiSS driver file
F— r_biss_rzt2_dat.h : BiSS driver file
F— r_biss_rzt2_if.h : BiSS driver file
F— r_biss_rzt2_private.h : BiSS driver file
L— bissc
F— r_bissc_rzt2.c : BiSS-C driver file
— r_bissc_rzt2_config.h : BiSS-C driver file
F— r_bissc_rzt2_if.h : BiSS-C driver file
L— r_bissc_rzt2_private.h : BiSS-C driver file
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RZ/T2H Group Encoder I/F BiSS-C sample program

The file structure of the RZ_T2H_CR52_0_primary folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L— src

L— hal_entry.c : CA55 start-up program
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RZ/T2H Group

Encoder I/F BiSS-C sample program

3. About BiSS Sample Program

This section contains information necessary to use the complete set of BiSS sample program.

3.1

3.1.

Software Information

1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and BiSS, BiSS-C driver is shown in following table. This table
does not include the memory size used by Flexible Software Package or C language libraries of the

compiler.
(1) CR52 ver.
ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
BiSS, BiSS-C driver Code 3.7 3.5
Data (with initial value) 0.0 0.0
Data (without initial value) 0.9 0.9
Constant Data 0.3 0.3
Sample program Code 3.1 3.4
Data (with initial value) 0.0 0.0
Data (without initial value) 0.6 0.6
Constant Data 1.5 1.6
(2) CAb55 ver.
ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
BiSS, BiSS-C driver Code 5.8 4.9
Data (with initial value) 0.0 0.0
Data (without initial value) 1.1 1.1
Constant Data 04 0.5
Sample program Code 4.9 6.1
Data (with initial value) 0.0 0.0
Data (without initial value) 0.7 0.7
Constant Data 1.7 1.7
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RZ/T2H Group

Encoder I/F BiSS-C sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2H

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of the Target Board
SW1-4: ON
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set to xSPI1 boot mode)

CN39: Short between 2-3pin (Set VDD1833_2 to 3.3V)
CN40: Short between 2-3pin (Set VDD1833_3 to 3.3V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833 6 to 3.3V)

Note: To use target board RTK9RZT2HOCW1000BJ with connecting RS-485 board, power on/off by
plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on.

R11ANO790EJ0201 Rev.2.01
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RZ/T2H Group

Encoder I/F BiSS-C sample program

®)

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

Used pin for Target Board

follows.
Channel Port Name Pin Input/Output Voltage Description
Header Domain
BiSS0O ENCIFDIO (SLO) CN2 #9 Input VDD33 Sensor / Control data
ENCIFCKO (MAQ) CN2 #3 Output VDD33 Clock / Control data
BiSS1 ENCIFDI1 (SL1) CN2 #8 Input VDD1833_3 | Sensor / Control data
ENCIFCK1 (MA1) CN2 #2 Output VDD1833_3 | Clock / Control data
BiSS2 ENCIFDI2 (SL2) CN2 #17 Input VDD33 Sensor / Control data
ENCIFCK2 (MA2) CN2 #11 Output VDD33 Clock / Control data
BiSS3 ENCIFDI3 (SL3) CN2 #18 Input VDD33 Sensor / Control data
ENCIFCK3 (MA3) CN2 #12 Output VDD33 Clock / Control data
BiSS4 ENCIFDI4 (SL4) CN2 #27 Input VDD1833 5 | Sensor/ Control data
ENCIFCK4 (MA4) CN2 #21 Output VDD33 Clock / Control data
BiSS5 ENCIFDI5 (SL5) CN2 #26 Input VDD1833_6 | Sensor / Control data
ENCIFCKS (MA5) CN2 #20 Output VDD1833_6 | Clock / Control data
BiSS6 ENCIFDI6 (SL6) CN3 #9 Input VDD1833_3 | Sensor/ Control data
ENCIFCKG6 (MAB) CN3 #3 Output VDD1833_3 | Clock / Control data
BiSS7 ENCIFDI7 (SL7) CN3 #8 Input VDD1833_3 | Sensor / Control data
ENCIFCKY7 (MA7) CN3 #2 Output VDD1833_3 | Clock / Control data
BiSS8 ENCIFDI8 (SL8) CN3 #17 Input VDD33 Sensor / Control data
ENCIFCKS8 (MAS8) CN3 #11 Output VDD33 Clock / Control data
BiSS9 ENCIFDI9 (SL9) CN3 #18 Input VDD1833_2 | Sensor / Control data
ENCIFCK9 (MA9) CN3 #12 Output VDD1833_2 | Clock / Control data
BiSS10 ENCIFDI10 (SL10) | CN3 #27 Input VDD1833_2 | Sensor/ Control data
ENCIFCK10 (MA10) | CN3 #21 Output VDD1833_2 | Clock / Control data
BiSS11 ENCIFDI1 (SL11) CN3 #26 Input VDD1833_2 | Sensor / Control data
ENCIFCK11 (MA11) | CN3 #20 Output VDD1833_2 | Clock / Control data
BiSS12 ENCIFDI12 (SL12) | CN10#9 Input VDD1833 6 | Sensor/ Control data
ENCIFCK12 (MA12) | CN10 #3 Output VDD1833_6 | Clock / Control data
BiSS13 ENCIFDI13 (SL13) | CN10 #8 Input VDD1833_6 | Sensor / Control data
ENCIFCK13 (MA13) | CN10 #2 Output VDD1833_6 | Clock / Control data
BiSS14 ENCIFDI14 (SL14) | CN10#17 Input VDD33 Sensor / Control data
ENCIFCK14 (MA14) | CN10 #11 Output vVDD33 Clock / Control data
BiSS15 ENCIFDI15 (SL15) | CN10 #18 Input VDD33 Sensor / Control data
ENCIFCK15 (MA15) | CN10 #12 Output VDD33 Clock / Control data
R11ANO790EJ0201 Rev.2.01 Page 7 of 18
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RZ/T2H Group

Encoder I/F BiSS-C sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_biss.zip and copy the extracted source files to the desired location.
Activate EWARM.

2
3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H_biss.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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RZ/T2H Group Encoder I/F BiSS-C sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

E C¥1_Prog¥Wor¥Work_C¥Work_EWA_960_2¥RZT2H_BiSS_release_chk - FSP Smart Configurator - [m] X
File Window Run Help
927 [RZT2H_BiSS5_release_chk] FSP Configuration x il FSP Visualization = 0
0 : = = "

Summary Generate Project Content L]

Project Summary —— A

Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: RIADSGOTIM44GBG

Core: CR52 CPUD

FSP Version: 220
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_2/RZT2H_BiSS_release_chk =4

Selected software components

Board support package for R9A09G07TM44GEG v2.20
Board support package for RZT2H w220 v
Board support package for RZT2H - FSP Data w220
JON
Support L
Summary | BSP | Clocks | Pins| Interrupts | Event Links | Stacks | Components » fLf
B 8 = B B Console ~-=08

[ Properties [2 Problems

Property Value No consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug¥Exe¥RZ_T2H_biss.out is generated.

(4) Sample Program Execution Procedure
After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group BiSS-C Sample Program Application Note.

¥ COM18 - Tera Term VT

File Edit Setup Control Window Help
art
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RZ/T2H Group Encoder I/F BiSS-C sample program

3.3.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CR52_biss.zip and copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select

Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.
4 Select a project, check Copy Project to Workspace, and click [Finish].
5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

Q BiSS_release_chk - e studio - *
File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help
| ® -] -initp~ Q- Q E||Eoc
5 Project Expl.. x| = O = O ||8= Outline X = 8 5.
= /5., 7 E There is no active editor that |
v [z RZ_T2H_biss [Debug] provides an outline.
k! Includes
C
{:_} configuration.xml
= RZ_[2H_biss Debug_Fl
K| RZ T2H_biss Debug_Fl
(@) Developer Assistance
71 Problems x| B Ivy-I| @O FO/(714- | @ -+ F539F- | AX-F-¥2aF) f § 708
0 errors, 13 warnings, 0 others
Description Resource Path Location Type
5 Warnings (13 items)
< >

R11AN0790EJ0201 Rev.2.01
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RZ/T2H Group Encoder I/F BiSS-C sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

{8 5SS relesse chk - RZ T2H _biss/configuration xmil - € studio O X
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
B-R-inits- Q- Q E|Ece
&5 Project Explorer X = O || [RZ_T2H_biss] FSP Configuration X e | 0 Qutline X =0
=ik 8 Summary (%] There is no active editor that provides an
v =5 RZ_T2H_biss [Debug] Generate Project Content outline,
0 Includes
& src Project Summary A
54 configuration.xml RENESAS
| RZ_T2H _biss Debug_Flat,jlink Board: RZT2H Evaluation Board (RAM execution without flash memory)
%] RZ_T2H_biss Debug_Flatlaunch|| | Device: ROADSGOTIMA4GBG
(7) Developer Assistance Core: CR52 CPUD
Toolchain: GCC for Renesas RZ
Toolchain Version: 122 1.arm-12-24
FSP Version: 220
Project Type: Flat
Location: C:/1_ProgMWork/Work_C/AVeork_E25_RZ...2.0/BiSS_release_chk/RZ_T2H_biss s
Selected software components
Board support package for R9A09G077M44GBG v2.2.0
Board support package for RZT2H v2.2.0 v
Board support package for RZT2H - FSP Data v2.2.0
Jo) (-
Support
Summary | BSP | Clocks | Pins| Interrupts | Event Links | Stacks| Components
171 Problems X | @ 3vy-Ji| O F0/(71-| @ AV-b-T577- | A¥-F-¥227) f=d
0 errors, 13 warnings, 0 others
Description Resource Path Location Type
i, Warnings (13 items)
< >
5 configuration.xm - RZ_T2H_biss

7 Select [Project] menu -> [Build All]
The Debug¥RZ_T2H_biss.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.

3 Click [Run] menu -> [Resume] to run the sample program

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group BiSS-C Sample Program Application Note.

M| COM18 - Tera Term VT [m| X

File Edit Setup Control Window Help
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RZ/T2H Group

Encoder I/F BiSS-C sample program

3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_biss.zip and copy the extracted source files to the desired location.

Activate EWARM.

Open the extracted source file RZ_T2H _CR52_0 primary -> RZ_T2H_CR52_0_primary.eww.

2
3 Select [File] menu -> [Open Workspace].
4
5

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
You can also start the FSP Smart Configurator directly from the command prompt by specifying the

folder where it is installed.

R11ANO790EJ0201 Rev.2.01
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RZ/T2H Group
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6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

File Window Run Help

{."-:‘} *[RZ_T2H_CR52_0_primary] FSP Configuration X

Summary

E.

Project Summary ~ ~
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memary)
Device: ROADSGOTTM4A4GBG
Core: CR52 CPUO
FSP Version: 2.2.0
Project Type: Flat
Location: C:11_Prog/Work/Work_C/Work_EWA_96__release_chk/RZ_T2H_CR52_0_primary =/
Selected software components
Board support package for ROADSGO77TM44GBG v2.20
Board support package for RZT2H v2.2.0 v
Board support package for RZT2H - FSP Data v2.2.0

G C¥1_Prog¥Work¥Work_C¥Work_EWA_950_2¥RZT2H_BiSS_CASS_release_chk¥RZ_T2H_CRS2_0_primary - FSP Smart Configurater

==

% FSP Visuglization

Generate Project Content,

| Summary | BSP | Clocks| Pins| Interrupts | Event Links| Stacks| Components > A8l

[ Properties [£] Problems oAl E Y § = O B Console BE & | =8
Selection from FSP Visualization RZ/TFSP

Property Value

< >

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.

The file Debug¥Exe¥RZ_T2H_CR52_0_primary.sbd is generated.
9 Select [File] menu -> [Open Workspace].

10 Open the extracted source file RZ_T2H_CA55_0_biss -> RZ_T2H_CA55_0_primary.eww.
(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.

Please build the primary project in advance.)
11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.

12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,

rzt_cfg, rzt_gen, script and .setting folders will be generated.

G C¥1_Prog¥WorkiWork_C¥Work EWA 960 2¥RZT2H_BiSS CASS_release chk¥RZ T2H_CAS5_0_biss - FSP Smart Configurator - m] X

File Window Run Help

E.

| Summary | BSP | Clocks | Pins| Interrupt:

[E] Properties [2] Problems ET

Properties are not available.

s | Event Links| Stacks | Components

8% "[RZ_T2H_CAS5_0_biss] FSP Configuration 3¢ el % FSP Visualization = B8
..... = =
Summary Generate Project Content L] N i
Project Summal
! v RENESAS = TIILIIIII Il e Bl L
Board: RZT2H Evaluation Beard (RAM execution without flash memory)
Device: RIADSGOTTMA4GBG
Core: CABS Corel
FSP Version: 2.2.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96..55 release_chk/RZ_T2H_CAS5_0_biss o=
Selected software components
Board support package for ROAD9GOTTMA4GBG v2.2.0
Board support package for RZT2H v2.2.0 v
Board support package for RZT2H - FSP Data v2.2.0

= 08 B Console
RZ/TFsP

13 When project generation is complete, close the Smart Configurator.
14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug¥Exe¥ RZ_T2H_CAS55_0_biss.out is generated.
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RZ/T2H Group Encoder I/F BiSS-C sample program

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55 0_biss project is launched.

2 Inthe workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 Inthe workspace of RZ_T2H_CA55 0_biss, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group BiSS-C Sample Program Application Note.

¥ COM1E - Tera Term VT - O *

Edit Setup Contrel Window Help

3.4.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary.)
GCC ARM A-Profile (Aarch64 bare-metal) 10.3.1.20210621 (Used by RZ_T2H_CA55 0 _biss.)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_ CA55_biss.zip and copy the expanded source file to any location.
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].
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RZ/T2H Group Encoder I/F BiSS-C sample program

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer
pane of e? studio to open it.

Q BiSS CASS release chk - & studio — O s
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
| &R - LR -2 Q ®|[Eoc-
I Project Explorer % = 0 = 0O ||5= Qutline X = 0|eg
=5 7 § There is no active editor that | (£8)
v [25 RZ_T2H_CAS55_0_biss provides an outline.
[l Includes
 src

& configuration.xml
| RZ_T2H_CAS55 0 biss Debug_Flat.jlink
|X] RZ_T2H_CAS55_0_biss Debug_Flat.laun
() Developer Assistance

~ IS RZ_T2H_CR52_o_primary [Debug
[} Includes

Iz

—

T O T L fimary Debug_Flatj “., Problems X | & Console| [ Properties @ Smart Browser T Smart Manual T E = 0
[#] RZ_T2H_CRS2_0_primary Debug_Flat | |0 emors, 26 wamings, O OthELS

() Developer Assistance Description Resource Path Location Type

£ Warnings (26 items)

< >

i,é:? configuration.xml - RZ_T2H_CR52_o_primary

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated in the RZ_T2H_CR52_0_primary

B BiSS_CASS.release_chk - RZ_T2H_CR52_o_primary/configuration.xmi - e studio - o x
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
| ®-& - wife Qv o ®|[@Boc
[0 Project Bxplorer 3| 5 G 7 & = 8 |[{# [RZ_T2H_CRs2_o_primary] FSP Configuration > el |2 Outline =@
v 55 RZ_T2H _CASS 0 biss Summary There is no active editor that provides | E3)
il Includes Generate Project Content fl | an outline.
8 src
{8 configuration.xml Project Summary o
|2 RZ_T2H_CAS5_0_biss Debug_Flat.jlink RENESAS
%] RZ T2H_CAS5 0 biss Debug Flatlaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
) C@R)ZDT;E‘E::’ZA“‘S“”" Device: ROAOSGOTTMA4GBG
V= e —o-primary Core: CR52 CPUO
% " Toolchain: GCC for Renesas RZ
— Toolchain Version: 122 1.arm-12-24
£} configuration.xm
2 RZ_T2H_CRS2.0_primary Debug_Flatjlink FSP Version: 220
%] Rz_T2H_CRS2_0_primary Debug_Flatlaunch|| | Project Type: Flat
(@ Developer Assistance Location: C:/1_ProgiWorkiWork_ChWork_E2S_RZ..release_chk/RZ_T2H_CR52_o_primary &=
Selected software components
Board support package for RSA09G077TM44GBG v220
Board support package for RZT2H v220 v
Board support package for RZT2H - FSP Data v220
m Support @
Summary | BSP| Clocks | Pins| Intemupts | Event Links| Stacks| Components
1 Problems > | B Console | [ Properties| @ Smart Browser| K5 Smart Manual y § = O
0 errors, 26 warnings, 0 others
Description Resource Path Location Type
5 Warnings (26 items)
< >

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build
Project].
The file Debug¥RZ_T2H_CR52_0_primary.sbd is generated.

8 Double-click the configuration.xml of the RZ_T2H_CA55_0_biss project in the Project Explorer pane of
e? studio to open it. (RZ_T2H_CR52_0_ primary.sbd of the primary project is referenced to open this
configuration file. Please build the primary project in advance.)
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9 Click Generate Project Content in the FSP Configuration pane of e? studio. The rzt, rzt_cfg, rzt_gen,
script, .settings folders are generated in the RZ_T2H_CA55_0_biss project.

H ®-4- L
5 ProjectExplorer X | B % 7 § = O
~ =% RZ_T2H_CAS5_0_biss [Debug

) Includes

8 src

& configuration.xml

[2) RZ_T2H_CAS5 0. biss Debug Flatjlink
%] RZ_T2H_CAs5_0_biss Debug_Flatlaunch
(Z) Developer Assistance

~ [ RZ_T2H_CRS2_0_primary

g

Binaries

il Includes

&z

(2 rzt_gen

B src

(&= Debug

&= rztcfg

& script

4 configuration.ml

[2] RZ_T2H_CRs2_0_primary Debug_Flat jlink
[] RZ_T2H_CRS52_0_primary Debug_Flat.launch
Bl rtcfgmxt

(2) Developer Assistance

) 8iSS CASS release_chk - RZ_T2H_CASS 0. biss/configuration.sml - & studio
File Edit Source Refactor Mavigate Search Project RencsasViews Run Window Help

- [m) x

Q iE|Eucs

£ [RZ_T2H_CRS2_0_primany] FSP Configuration | 44¢ *[RZ_T2H_CAS5_0_biss] FSP Co ey 0 Outline

Summary

Generate Project Content | an outline.

Project Summary

RENESAS ~
Board: RZT2H Evaluation Board (RAM execution without flash memaory)
Device: RIAQIGOTTMA4GBG
Core: CA55 Corel
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolehain 4 5 4 20210621
Version:
FSP Version:

220

Project Type: Flat
Location: C:1_Prog/Work/Work_C/Mork_E25_RZ..55_release_chk/iRZ_T2H_CAB5_0_biss o«

Selected software components

=8|,

There is no active editor that provides | £8)

Q=

COT Build Console [RZ_T2H_CAS5_0_biss]

< >

£ configuration.xml - RZ_T2H_CAS5_0 biss

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

[#1 Problems | & Console X | [ Properties| @ Smart Browser| 5 Smart Manual

Board support package for ROA09GOTTM44GBG v2.2.0
Board support package for RZT2H v220 v
Board support package for RZT2H - FSP Data v2.2.0

X| O ¢S LEeE

“ElMe-r--0o

10 Select [Project] menu -> [Build All]

Files Debug¥RZ T2H CA55_0_biss.elf is generated.

(4)

Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the

following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the

RZ_T2H_CR52_0_primary project.

Click [Debug] to start downloading to internal RAM.
2 Click [Run] menu -> [Resume] to run the CA55 start-up program.
3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the

RZ_T2H_CA55_0_biss project.

4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed.

& Launcher

A Renesas GDB debug session is already active.

[] Remember my decision

X

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

5 If 'Proceed with launch' is displayed, select 'Yes'.

Cancel

6 Click [Debug] to start downloading to internal RAM.
7 Click [Run] menu -> [Resume] to run the sample program.
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RZ/T2H Group Encoder I/F BiSS-C sample program

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group BiSS-C Sample Program Application Note.

¥T| COM18 - Tera Term VT - O X
File Edit Setup Control Window Help

AME am stTart

t
|
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Revision History

Description
Rev. Date Page Summary
0.50 Sep 29.23 First Edition issued.
0.60 Apr 19.24 1-4 Update the application note and release note version number.

Update sample program version to 0.6 (Support FSP v1.3.0)
Update file structure. Add structure of CA55 version.
S) Update memory size information. Add information of CA55
ver.

1,6 Update description of the board name.
8-11 Update build environment and figures for CR52 ver.
12-16 | Add development procedures for CA55 ver.

2.00 Nov 21.24 2-4 Update revisions of the application note and the release note.
Update sample program version to 2.0. (Supported FSP
v2.2.0.)
Update the file structure.

5 Update memory size information.

6 Add xSPI11 boot mode in setting of the target board.
8-17 Update build environment for FSP v2.2.0. Figures are
replaced.

2.01 Dec 13.24 2,3 Update revision of the release note.
Correct path name of the FSP SC in the sample program
environment files to use default installation path.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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